SmartSoft-TOF Software Release Notes
___________________________________________________________________________

Release 2.5.0 – December, 2016
___________________________________________________________________________

OVERVIEW

SmartSoft-TOF V2.5.0:  Support 64-bit SmartSoft-TOF window program; Integrated Fast Zalar 
Note: This is the first version of SmartSoft-TOF that supports both 32-bit and 64-bit installations. The 64-bit installation takes advantage of the larger memory address space and increased RAM size.  This allows the SmartSoft software to better handle large data files and increased pixel display resolutions.
NEW FEATURES
UI

1. Menu Bar>Hardware>System Configuration>Fast Zalar: Support the Fast Zalar option if the system has a Hot Cold Stage.
2. Menu Bar>Hardware>Detector Calibration…>Calibration File Name: Previous invalid ‘_’, ‘+’, ‘~’ are now allowed.
3. Menu Bar>Automation>AutoTool>GCIB: Close Gas Valve. Customers can close the gas valve but keep GCIB in ready mode to keep the beam current stable for next day.

4. Menu Bar>System>Zip Log Files: Allow zipping of system log files from a time period with Start and End.
5. Menu Bar>Sequencer…>Diagnostics…>Abort: Abort Data Acq and TDCs. This may help if the acquisition hangs.
Sample
4. Stage>Fast Zalar: Allow Start and Stop of Fast Zalar (high speed rotation) if Sample Type is Fast Zalar.

TOF
7. Data Manager>Sample>Sample Type: Added a new Sample Type called Fast Zalar.

Hardware

8. LMIG>Properties…>Bi Source: Added a new field called Extractor Voltage Limit (V) for limiting the extractor voltage when emission control is regulated in Step 2, Step 3, and first part of Step 4.  It is default to -8000 for the new Bi tip.  If you are using the old Bi tip, please set it to -12,000V for 20-750 or --15,000V for 20-751.  The limit for hold time for Step 1, Step 2, and Step 3 is increased to 100,000 seconds.
BUG FIXES

UI
9. Menu Bar>Hardware>System Configuration>Intro Camera: Make it backward compatible and doesn’t require users to re-select Intro Camera configuration. Previous Yes | No will be remapped to Canon | None.
System
10. Intro Photo>Take Photo: Prevent software hang caused by Auto Focus failure. If Take Photo detects an Auto Focus error, it will display an error instead of proceeding and waiting forever.
11. Intro Photo>Calibrate>Calibrate Properties>Center Calibration Position: Hook up missing callback. 
12. Vacuum>Properties>Pump Intro Wait Time: Changed the maxium wait time from 60 minutes to 24 hours to support gassy samples.
13. Vacuum>Properties>Transfer Sample Main and Transfer Sample Intro: Remove these parameters as they were not used.
14. Vacuum>Pump Intro: Do not open V4 if Pump Intro fails and cannot reach Intro Pre-Pump pressure.
TOF
15. FIB>Abort: Fixed beam damage by waiting for the sputter process to complete before restoring hardware parameters.

Hardware

16. LMIG>Load Setting: Block user from loading setting when sample is at Intro, stage is busy, stage aperture is busy or requires initialization.

17. LMIG>Lens 2 Steering Y: Fixed the range to -100 to +100.

18. C60>Load Setting: Block user from load setting if aperture requires initialization.

19. Analyzer>Load Setting: Block user from loading setting when sample is at Intro.  When sample is at intro, HV is disabled, and won’t be able to ramp DSI supplies.

20. Load Setting: Display load setting error with red salient on status line.
___________________________________________________________________________

Release 2.4.0 – October, 2016
___________________________________________________________________________

OVERVIEW

SmartSoft-TOF V2.4.0:  Support for new MS/MS and GigE Camera configurations; New Features; Bug Fixing 

NEW FEATURES

UI

1. Menu Bar>File>Restart TOF-DR: Re-establish communication with TOF-DR when TOF-DR becomes out-of-sync, hung, or crashed. This frees us from restarting SmartSoft-TOF, which may require shutting down of hardware.

2. Menu Bar>Hardware>System Configuration>MSMS: Support parallel MS and MS/MS data acquisition.
3. Menu Bar>Hardware>System Configuration>Intro Camera: Support GigE camera.
4. Menu Bar>Hardware>System Configuration>GCIB: Support GCIB gun configuration.  The 06-2100 has three turbo pumps and a magnetic coil.  The 06-2600 has two turbo pumps and a permanent magnet.

5. Menu Bar>Tools>Sputter Tool>Raster Size (um): Allow editing of raster size of the selected sputter gun.

6. Menu Bar>Tools>Sputter Tool>Sputter Time: Enter sputter time in seconds.
7. Menu Bar>Automation>AutoTool>FIB: Support FIB mill/polish tasks. Customers can shut down the FIB gun when done and get e-mail notification.

8. Menu Bar>System>Zip Log Files: Provide a tool to easily zip up system logs, application logs, and settings files for problem diagnostics.

9. Menu Bar>Exit: If acquisition or SED is running, prompt users to confirm exit with shutting down of acquisition or SED.
10. Menu Bar>Sequencer…>Diagnostics…>Sequencer>Save Bulk Data: Save raw bulk data for problem diagnostics.
System

11. Intro Photo>Properties…>Calibrate: The Intro Camera application now includes a simplified point & click interface which allows for drawing an area on the intro photo to calibrate the image.  This point & click interface is also available to define the clipping area.  Also new is the ability to import a BMP or JPEG image from and external camera source (e.g. an external microscope).  This import feature can also be used to recalibrate a previous taken intro “.pho” photo file.

12. Valve Viewer>ToolBar>Large Pressure Display: The large pressure displays are shown in a sizable and movable window.

13. Valve Viewer>GCIB: Show three turbo pumps for 06-2100 and two turbo pumps for 06-2600.
14. Vacuum>Properties>Intro Ion Gauge: Add support to calibrate ion gauge at atmospheric pressure and system pressure.
Sample
15. Detector>Detector Camera: Add opening and closing of isolation valve (V7).

16. Position List>Toolbar>Lock Button: A Lock button is added to the position list which, when pressed, prevents editing the position list. The Lock button automatically gets pressed when running AutoTool.

TOF
21. Data Manager>Properties>Filename>Ion Polarity: The auto file naming feature has been expanded to include polarity. Use ‘Pos’ for Positive Ions and ‘Neg’ for Negative Ions.

22. Acquisition Properties: Support additional 64x64 and 128x128 acquisition resolution.  This will speed up acquisitions especially for mosaic map.  This feature requires DataAcq model 912 and TDC firmware update.
23. Start Acquisition: Provide an action button to open V7, V8, V11, or V14 if closed.
24. Spectrum/Profile/Map>Support parallel MS and MS/MS data acquisition for MS/MS equipped system.

25. Spectrum>Properties>Spectrum>On Complete: Save RAW file at the completion of an acquisition.  This can be used to avoid saving unnecessary files during alignment/tweaking/tuning.
26. Spectrum>Properties>Spectrum>Save Spectrum File: Autosave Spectrum File (.tdc) at the completion of an acquisition.

27. Spectrum>Properties>Spectrum>Save Profile File: Autosave Profile File (.dat) at the completion of an acquisition.

28. Spectrum>Properties>Spectrum>Save Image File: Autosave Image File (.ims) at the completion of an acquisition.

29. Spectrum>Diagnostics>TDC>Threshold:  Set minimum input pulse height accepted.

30. Profile>Acquisition Status>Charge Comp: Show remaining charge comp time.

31. Map>Mosaic Area>Maximum Tiles>Specify the maximum number of tiles.

32. Charge Comp>Ion Neutralize with Gas Gun: Limit settings to neutralize settings.

33. FIB> Continuously Variable Mill (CVM): Support a new milling process to mill descending slices approaching the face of interest similar to the polish process for better surface integrity.
34. FIB: Broaden fiducial mark for better visual recognition.
35. FIB: Integrated to SmartSoft-TOF.  This is a paid feature. 
Hardware

36. Show gun errors for LMIG, C60, GCIB, Cesium, Gas Gun, Ion Neut, E-Neut in a consistent way by using red salient in the status bar.

37. LMIG>PHI LMIG Emitter Status: Show both target and readback values. Add heater resistance readback.

38. Analyzer/MS2>Fix ramping of supplies never complete by adding a 2-minute timeout.

39. MS2>Properties>Mass Calib: Support viewing and editing of MS2 Mass Calibration parameters. These mass calibration parameters are saved in the raw data header. When MS2 spectrum is calibrated during acquisition, these parameters are updated in the UI and the raw data header.

40. Gas Gun>Neutralize: Check the box and _NEUT will be appended to setting name to help differentiating neutralize settings from sputter settings.
41. Gas Gun>Objective Lens: Support wobbling to tune 5-degree bend.

42. GCIB>Properties>Source>Beam Ramp Rate (kV/sec): Ramp beam voltage slowly when switching to Ready mode.
43. Hardware shutdown/interlock detected>Provide a clear button to clear shutdown or interlock when detected.  This includes LMIG vacuum interlock, DSI shutdown and MS2 shutdown.

Others
44. Use Service-TOF desktop shortcut to run SmartSoft-TOF in service mode.  This means everything is in simulation except for SVC and Varian ion gauge.
BUG FIXES

UI

45. Menu Bar>Hardware>Bake>Bake Zones: Clean up the bake zone and strip terminology to match hardware.

46. Menu Bar>Tools>Ammeter Tool>Faraday Cup: Do not lower Z and move stage to Faraday Cup position if stage is already at the Faraday Cup position.

47. Menu Bar>Tools>Sputter Tool>Raster Gun/DEM Delay: Remove them as they were not used.
48. Status Bar>Polarity: Positive (+) Ions/Polarity: Negative (-) Ions: Put up an hour glass to wait for both DSI and MS2 Supplies to settle.
49. Status Bar>Error Message>Display acquisition, vacuum, and sample transfer errors with red salient.
Sample
50. Stage>Hot Cold: Stop regulating hot cold stage temperature once there are four consecutive sampling temperature errors. This is to avoid excessive use of CPU time to catch up temperature sampling.

51. Stage>Hot Cold: Use backfill intro temperature limits instead of hot/cold warning limits for backfill intro temperature check. 

52. Stage>Hot Cold: Remove backfill temperature protection after pump intro is started so users don’t need to wait until intro pressure drops below 1.3E-2 Pa.
53. Stage>Hot Cold>Properties>Relay and Sensor Type: Remove them as they were not used.
54. Sample Transfer>Extract: Fix the problem of not able to backfill intro after transfer sample close V1 and disallow any future vacuum tasks.
TOF
55. Large raw data file ASCII header: Remove the previous limit of 40K bytes. The symptom was no data display.

56. Data Manager>Playback Raw Data File: Block launching of raw data file playback if acquisition is in progress.

57. Data Manager>LabBook>Comment: Allow editing of comment.  The symptom was no data display in playback and the raw data file is corrupted. 

58. Data Manager>LabBook>Filename: The list of invalid characters now includes '~', '_', and '+'.  SmartSoft-TOF uses '~' when a duplicate filename is found. The complete list of invalid characters is: '/\:*?<>|~_+'.
59. TOF File Editor>Allow editing of ASCII header for raw data files.

60. Profile>TDC Buffer error>Improve error handling so SmartSoft-TOF doesn’t hang after profile error. Depending on the cause of TDC buffer error, software may recover and continue on with the acquisition.

61. Spectrum/Profile/Map>Restart: Disallow restart right after polarity switch.

62. Spectrum/Profile/Map>Dose: Fix dose calculation.

Hardware

63. LMIG>Emitter Startup & Shutdown: Improve the robustness so startup and shutdown achieve a higher rate of success. Improve error handling.

64. LMIG>Firmware lock: Limit sampling frequency (emission current and suppressor voltage update) to at most once every second to ensure software is responsive. 

65. Au and Ga Emitter Shutdown: Add turning off the heater.
66. GCIB: With the support of 06-2600, we will skip the control of Magnet Current.  The symptom was having “burn fault” and emission current is not set correctly when switching gun mode or load setting.
67. GCIB: Send down filament current limit when SmartSoft-TOF comes up. This is to ensure the limit is set to a known good value.

68. KnobBox: When the KnobBox is configured but not connected (and not simulated); errors are continuously generated in the system log.  This bug will cause the hard drive to fill with log data over the course of a few days.  Protection has been added to log only one error in the system log on startup.  
69. WinUSB>Fix crashes at startup if USB devices are disconnected and not simulated.

HELPFUL HINTS
KNOWN ISSUES AND LIMITATIONS
70. After installing V2.4.0, please run ConfigurationSetup.exe and reselect your Intro Camera option.  Otherwise, you will get Create Session error. 
___________________________________________________________________________

Release 2.2.3 – March, 2016
___________________________________________________________________________

OVERVIEW

SmartSoft-TOF V2.2.3:  Bug Fixing 

BUG FIXES

Hardware
1. Hardware>LMIG>Properties>Bi Source: Allow Normal Heat Current (A) to stay as greater than 3.8 A after restarting SmartSoft-TOF.

2. Hardware>GCIB: In load setting or gun mode change, make sure emission current is sent down to hardware even if we have a burn fault. Protect the filament from being left on when turning the gun mode to off. 
___________________________________________________________________________
Release 2.2.2 – February, 2016

___________________________________________________________________________

OVERVIEW

SmartSoft-TOF V2.2.2:  Bug Fixing 

BUG FIXES

System

3. Vacuum>Properties: Open up the range for Vent Intro to [1E+2, 1.01E+5] Pascal to support using Argon for venting.

Hardware

4. Hardware>LMIG>Properties: Open up the maximum value for Max Heater Current (A) to 4.0 A for Bi.

___________________________________________________________________________

Release 2.2.1 – December, 2015
___________________________________________________________________________

OVERVIEW

SmartSoft-TOF V2.2.1:  Adds MS/MS Support (hardware option); New Features; Bug Fixing 
NEW FEATURES

UI

1. Menu Bar>Tools>System Log: Backup copies of the system log are now stored in the C:\SmartSoft-AES\Log directory

2. Status Bar: The size of the status line fields can now be customized by clicking and dragging the edge of the field.  Fields can be returned to their default size by selecting the Reset Default Size option from the status line context menu.

System
3. System>Intro Camera: External image files (.bmp, .jpg) can now be imported and used to navigate on the sample.  
Hardware

4. Hardware>LMIG: A new Settings Editor is available for viewing and editing the settings text files.  The Settings Editor is accessed through a context menu from the Settings Box.  This Settings Editor is available for all hardware applications.
5. Hardware>Ion Gun: The emission current startup ramping is optimized to improve the lifetime of the ionizer.
6. Menu Bar>Sequencer>LMIG: Fine Delay (250pSec) values are now calculated as a function of coarse delay. LMIG: Quad, Buncher; C60: Pulser 2
BUG FIXES
UI

7. Menu Bar>Hardware>System Configuration>Varian Gauge: The Varian gauge support is working.

8. Hardware>C60>MVA:  Duplication C60 aperture settings from have been removed from the setting list.
9. Hardware>Bake>Application Log: Duplicate entries in the Bake application log have been removed.
Sample
10. Sample>Stage>Hot Cold: Duplicate entries in the H/C Stage application log have been removed.
11. Spectrum>Properties>Spectrum>Save RAW File On Abort: Data files are now saved when an acquisition aborts because of an error.
System

12. System>Sample Transfer: For protection, the Sample Bias and Immersion Lens are set to 0 V when a sample is moved to the intro position; and return to voltage when the sample is moved back to the analysis position.
13. Sample>Sample Transfer: To improve the lifetime of the intro ion gauge, the ion gauge is disabled before backfilling intro; and re-enabled during pump intro.

14. System>Sample Transfer: For protection, the Backfill Intro task now checks that V1 is closed and that stage Z is at positive limit.
15. Sample>Intro Camera: Communication reliability with Canon camera has been improved. 

Hardware

16. Hardware>C60: Communication problems with the C-863 MVA aperture have been fixed.

17. Hardware>C60: User ranges are read from the controller instead of using hardcoded manufacturer numbers. The effect is we do better calculating in converting between DAC numbers and user values. Also updated the calibration offsets so the read backs matched those from the manufacturer.

18. Hardware>GCIB:  Tilt x, tilt y, rotation, and raster size calibration factors are now included in the GCIB settings.  Previous these values were properties.

19. Hardware>GCIB: Baud rate for PHI GCIB control must be set to 9600.  The baud rate is now correctly set when this configuration is changed.
20. Hardware>E-Neut: The E-Neut extractor voltage range is changed from [10, 75] V to [0, 75] V.

21. Hardware>LMIG: Lens1 and Lens2 now use wobbling support found in the firmware; this is identical to what was done in previous version of WinCadence software.
22. Hardware>LMIG>Properties>Raster: Mass Calibration Intercept field is difficult to edit because the field is displayed in scientific notation.  This has been fixed.
23. Hardware>LMIG>Source Properties>Lock: Refresh Rate field is no longer used and has been removed.
24. Hardware>LMIG>Schematic: LMIG labels for X and Y steering plates have been corrected.  These labels were inverted.
25. Hardware>LMIG>Diagnostics: a 20-751 read back value was added for Extractor Limit DAC

26. Analyzer>Spectrometer: the Post ESA Blanker value is now correctly set when in DC mode.
27. Hardware>I-Neut:  I-Neut is now blanked when switching from DC mode to Ready/Off mode.  Previously the bias voltage was set to 0.0, however this method did not effectively blank the beam. Gun is un-blanked when going back to DC mode.

HELPFUL HINTS 
KNOWN ISSUES AND LIMITATIONS

1. TOF>Spectrum: Acquisition appears to be running but nothing is displayed in TOF-DR.  

a) This problem is typically associated with a large raw data file ASCII header.  This should be verified by examining the file header in a WordPad style editor.  A fix is included in V2.2.1, which minimizes this problem.
___________________________________________________________________________

Release 2.1.0 – February, 2015

___________________________________________________________________________

OVERVIEW

SmartSoft-TOF V2.1.0:  20kV-C60 Ion Gun Supported as Primary Gun; Bug Fixing
NEW FEATURES

1. Menu Bar>System>E-Mail Notification: An e-mail or text message notification can be sent at the completion of an acquisition or AutoTool sequence.  Multiple notifications can be added to the AutoTool sequence to track the progress of the sequence.  Notifications can be sent to multiple e-mail addresses.
2. Menu Bar>System>Coffee Timer: AutoTool tasks can be scheduled to begin processing at a specified day and time. 
3. Hardware>LMIG: LMIG 20-751 - The suppressor range for the 20-751 LMIG control is changed from (-2000.0, 0.0) to (0.0, 2500.0).   This change is designed to improve the stability of the emission current during a long acquisition.  
4. Hardware>20kVC60: The 20kV-C60 ion gun is now fully supported as the primary ion gun.
HELPFUL HINTS

1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to another parameter field.  If the application is exited before the value is terminated the change will not be saved.

KNOWN ISSUES AND LIMITATIONS

___________________________________________________________________________

Release 2.0.0 – October, 2014

___________________________________________________________________________

OVERVIEW

SmartSoft-TOF V2.0.0: Represent an extensive rework of the instrument control software for the nanoTOF II system.  This version is built using the SmartSoft architecture and implements many of the capabilities found in other SmartSoft products.

For flexibility the data reduction software, TOF-DR, has been split from the instrument control software.  This allows for efficient data reduction using TOF-DR on an off-line computer.  On the instrument TOF-DR communicates directly with SmartSoft-TOF to display the data real-time.  Real-time data displayed in TOF-DR can be easily manipulated during data collection with no limitations. 
HELPFUL HINTS

1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to another parameter field.  If the application is exited before the value is terminated the change will not be saved.

KNOWN ISSUES AND LIMITATIONS
